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STARTING ROBUST TOMATO PLANTS FOR PLANT SALES
By, Jennifer Porwit, Ramsey County Master Gardener
February, 2019
Growing robust tomato plants from seeding to planting out in the garden is a process
with many steps. Each step is vital for growing plants that will please you and your
customers. I came up with the details through experimentation, accident, and
sometimes, desperation, growing plants for our annual Master Gardener Plant Sale.
START DATE: After a fair amount of angst each year as to when to start planting seeds
indoors, I finally settled on the third or fourth week of March as a time that seems to
work well. If I have a lot of varieties to plant, I do it over the space of several days.
CONTAINERS & CLEANLINESS: Since germinating tomato seeds are prone to damping
off disease, I make sure that I use only new containers or trays, or ones that have been
thoroughly washed and soaked in a bleach solution and rinsed.
mix 1 part bleach to 9 parts water
soak 10-15 minutes
rinse well with water
I used to use cell trays with one or two seeds per cell, but found that it was hard to get
the seedlings out when they got transplanted. Using cell trays changed one day when I
was sitting on a gym floor with little kids climbing all over me as I was trying to teach
them how to plant seeds. It soon became obvious that having them plant one seed at a
time wasn’t going to work. In desperation I scooped up starting mix in a 4.5 inch pot. I
had one of the kids take a pinch of seeds and then sprinkle them on the surface of the
mix. Then the child took a pencil, stirred the surface, and gently patted it down.
Several kids followed suit. I promised them that I would bring the pots back in a couple
weeks to show them what the new sprouts looked like. Since there was no garden for
the youngsters to plant the tomato plants into, I ended up with pots full of mini jungles
of tomato plants. As they grew, I decided that I would try to rescue them. I carefully
dumped out each pot and teased apart the small plants and potted them up
individually. I discovered that this was much easier than dealing with cell trays and have
started my tomato plants this way ever since.
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HOW TO PLANT: Usually, I plant about 20 seeds per 4.5 inch pot. All seeding and
transplanting is done into new or sterilized pots. Rather than stirring the seeds in, I

sprinkle seeds on top of the soil mix and then lightly cover with more mix. Lightly patting
helps ensure good contact between the soil and the seeds so that the seeds don’t stay
dry.
LABELING 1: Each pot
must be immediately
labeled! Unlabeled pots
all look exactly alike—
even two minutes after
seeding.
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SEED STARTING MIX: Everyone seems to have their
favorite seed starting mix. I have tried several
brands but have settled on using Schultz Potting Soil
Mix. It is inexpensive, holds moisture well, and still
has sufficient drainage. I use it for the initial
germination all the way through to the final potting.
It has a very small amount of fertilizer included in it.
Ferti-lome is another brand that is readily available.
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BOTTOM HEATING: For the initial germination, I set a seedling heat mat onto a dining
hall tray, jellyroll pan, or under a solid-bottom pot tray. Place the pots onto the heating
mat or into the pot tray. I usually remove the bottom heater mats after the seedlings
are transplanted up or when they get to be four inches tall in the initial seeding pot.
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One pot planted and waiting.
WATERING: At this stage I water almost exclusively from the bottom. To make sure that
the surface of the potting mix does not dry out, I loosely cover the pots with a sheet of
bubble wrap. Bubble wrap works well as it does not seal as tightly as a plastic kitchen
wrap, allowing for limited air circulation and room for the new sprouts to grow. The
bubble wrap is removed as soon as most of the seeds have germinated. It is important
to remove the bubble wrap so that the surface of the potting soil doesn’t remain too
damp. Even though the potting mix is nutrient poor and mostly sterile, stray dampingoff fungus spores may find their way to the surface of the pots and kill off all of the
young seedlings. Not all tomato seeds germinate in the same length of time. Don’t panic
if seeds planted at the same time sprout over the course of several days.
FERTILIZING: When the seeds do sprout, the plants are quite vigorous and require
regular but diluted fertilizer. Miracle Grow is one of several brands of readily dissolvable
fertilizer that can be used. Be careful not to over fertilize. I use about one teaspoon of
fertilizer to one gallon of water. I use this diluted fertilizer approximately every other
watering. If there is still water in the tray I know that I don’t need to water. Otherwise I
use the finger test to determine how dry the top of the soil is.
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NURSERY & LIGHTING: A four-foot-wide shelving unit works well for holding the trays
because then I can suspend a four-foot fluorescent shop light above each of the shelves,
leaving 1-2 inches of space between the lights and the potting mix surface (or the leaves
after germination). I probably will not switch to LED lights because the fluorescent bulbs
are cheap enough and they emit a small amount of heat that the baby plants appreciate.
Light from fluorescent bulbs is not identical to sunlight, but it is close enough to do a
good job when raising seedlings. I suspend the lights on chains so that I can raise or
lower them depending on the height of the plants. This set-up is in our basement in a
small room that I can keep warm with a small thermostatically controlled heater. Be
sure to only use a heater that automatically turns off if it falls over so that you don’t
start a fire.
The seeds can be started in other locations, but there are a couple things to remember.
Pots should not be placed on a windowsill. It is usually too cold next to a window for
adequate germination and growth. Also, sunlight coming in the window is not strong
enough for the same reason.
I leave the lights on at least 12 hours each day. I used to use a timer to turn the lights on
and off each day, but now I turn the lights on manually when I get up in the morning and
off when I go to bed at night. Do not leave the lights on for over 16 hours a day; plants
need some darkness and a rest period to grow well. I find that I keep a closer eye on
watering and distance from the lights when I do the job manually.
TRANSPLANTING 1: When the seedlings get to be around 4 inches tall (third or fourth
pair of true leaves) it is time for the first transplanting. Gently pop out of a pot all the
plants and potting soil. Gently separate the plants from each other. Separate out the
largest plants to pot up now and put the smaller plants back into the original pot so that
they can grow some more and get potted up later. Have a generous supply of two-inch
pots at hand (I clean and reuse these each year). Put a small amount of potting soil in
the bottom of the pot, place the seedling deep into the pot so that all the roots are near
the bottom. Fill in soil around the stem leaving the leaves just above the soil line. This is
very important. The top growth of the plant will slow down briefly, but additional roots
will grow all along the buried stem. (Only tomatoes will form roots along the stem this
way; do not do this with other seedlings!) Remove the bottom heater mats after the
seedlings get to be four inches tall in the initial seeding pot and when transplanting.
LABELING 2: Every pot must be labeled immediately after being transplanted. I use a
popsicle stick, tongue depressor, or vinyl stake with the variety name written on it with
a UV resistant pen or a weatherproof printed label.
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FUNGUS GNATS: One year, I ended up with an infestation of fungus gnats indoors.
Luckily, it was at a stage when the plants were already good sized, so they did not suffer
much damage before they went outside. I think that in the future I will put out yellow
sticky traps as soon as the seeds are sown to head off a problem. Yellow sticky traps
are placed horizontally at the soil surface when the plants are potted individually to
capture large numbers of egg laying adults. The gnats are attracted to yellow and are
easily removed on the trap before they can lay more eggs. Another option is to cover an
amber colored medicine bottle with Tanglefoot. Tanglefoot is usually used outside to
capture gypsy moths, apple maggots, etc., but it certainly is effective at capturing inside
pests as well.

The little black spots on the
bottle are captured insects.

TRANSPLANTING 2: When the plants have outgrown their two-inch pots they get
transplanted into 4.5 inch pots. Pop the plant and soil out of the two-inch pot and drop
it to the bottom of a 4.5-inch pot. Fill in the pot with soil up to the lower leaves (pinch
off some bottom leaves if the plant is very tall). Again, the top growth will be briefly
slowed, but roots will grow all along the stem that is below the soil surface.
Often, I have missed a pot of seedlings and didn’t get them transplanted into the twoinch pot in a timely manner. By this time the seedlings are a big, tall mess of tangled
plants. In this case, I tease them apart and plant them directly into 4.5-inch pots. This is
not ideal, but it is better than discarding them. I think that it would be fine to always
skip the step of potting in the 2-inch pot if you are cramped for time or if the seedlings
have gotten very tall.
LABELING 3: Move the labeled stick to the 4.5” pot with the transplanted plant.
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SPACE: At this point, the potted plants are taking up a lot more space than the pots of
seeds, but they still have the same watering and light requirements. The temperature
can be roughly room temperature, but it is best to keep them away from windows. If
twenty plants result from each seeded pot, you must provide accommodations for
twenty times as many pots. Calculate how many pots will fit per tray and use that figure
to calculate how much shelf space you need to fit all the trays. The potted-up plants still
need the grow lights until they are moved outdoors.
HARDENING OFF: It is now time to prepare a place outdoors for the plants to harden
off. Usually this is around the time that enough frost is out of the ground that a shovel
will penetrate full depth and the ends of the hoops can be pushed into the soil. By this
time the plants are getting quite big.
The exact form of this structure is unimportant as long as it has certain characteristics. It
should be of translucent material, such as heavy vinyl sheeting. There should be enough
room around the plants and well above them so that their leaves do not touch the
plastic. The north side of the enclosure should be liftable so that it can be propped open
all day to let breezes in and then closed down at night so that curious critters and/or
cold air can’t get in. Don’t leave the south side open because if plants are exposed to
direct sun for long periods before they are accustomed to being outside, they will dry
out quickly and get sunburn. If the weather is really foul, the sides can all stay down
during the day.
HOOP HOUSE PLANS: A tent frame or boards temporarily nailed together can form the
skeleton of the structure to be covered with the plastic. After suffering with jerry-rigged
arrangements for a couple years I decided to make a hoop house that could be put up
and taken down quickly and re-used every year. The hoops themselves are made from
UV resistant vinyl: 10’ electrical conduit that I bent using a heater that is used for
removing paint. They are shaped like an upside-down U where the legs are 4’ across
from each other. A 5’ post is set deep in the ground at each end of where the hoop
house will sit. Each end of each hoop is pushed into the ground about six inches and the
hoops are placed 4-5’ apart. They are not stable until they are tied to each other at the
tops and to the end posts. Then the ten-foot-wide poly sheeting is drawn over the top
and fastened down at each end with concrete blocks or rocks. It must be secure enough
that a strong wind will not blow the whole thing away. If you have extra hoops you can
put a couple of them over the top of the sheeting to help secure it. On occasion, I have
simply leaned 2 x 2’s or larger boards against the sides.
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Contrary to their time indoors, when the pots are outdoors they must have free
drainage. Do not keep them in solid bottomed trays.

A happy hoop house.
The exact timing of putting the plants
outdoors is quite flexible—it depends on
how cold it is outdoors and how crowded it
is getting indoors, as well as whether you
are able to tend to them every day when
they are outside. (It is possible to leave
them covered for a day or more if it is cool
and cloudy/rainy.) Before the trays of plants
are put out in the hoop house it is a good
idea to spread a layer of straw or newspaper
on the ground to act as temporary insulation
barrier.
Once the plants are out in the hoop house
they stay there until they are planted or
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donated. Every night the sides are lowered and secured so that the plants don’t suffer
from chill breezes or hungry animals. If a frost is predicted, I put five-gallon buckets of
hot water out in the house and cover the hoop house with tarps. A couple times over
the years leaves that touched the plastic got frosted a bit, but no serious damage
happened.
While the plants are in the hoop house I water them with a wand on the end of a hose.
Every other watering or so I use a sprinkling can of very dilute fertilizer. This way the
plants get used to water falling on them.
The last week before the
plant sale I completely
slide the plastic sheeting
off each day for increasing
lengths of time
(depending on the
weather). If it is really
cloudy the plants can
stand more time
unprotected. It still is
important to keep them
covered each night.
LABELING 4: Label pots with sticky-back labels before putting them out to sell. If you
labeled the seeds and the transplants when they were potted, this will be an easy task.
See examples of stickyback labels in Appendix 1.

Some varieties, like
Tumbler, refuse to stand
up straight without help.
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.

Even when young, determinate or dwarf indeterminate tomato plants are shorter than
indeterminate ones. All types of tomato plants should be planted deeply in the garden.
If the indeterminates are really tall they can be laid on their side for a day. The growing
tip will bend upwards toward the sun and then the plant can be planted in a trench
rather than in an extremely deep hole. All leaves that would end up underground
should be pinched off.
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The big sticky-back labels are put on the pots just before the plant sale. The colored inks
tend to run when wet, so the less time between final labeling and selling, the better.

While all of these various steps contribute to the growing of robust plants, probably
the most important is that of transplanting deeply into pots.

**Slowing down the top growth and adding to the root system is key**
The second most important step is keeping them outdoors in the hoop house or
similar structure for quite a while. The plants then grow very stocky as opposed to
lanky.
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Appendix 1—CREATING LABELS

by Joe Baltrukonis, Ramsey Co. MG

The labels that we use are printed 10 to a sheet. We have tested these for durability,
and they will generally last on the final pot for at least 2 weeks. If the labels do get wet,
the ink will bleed and the label will become illegible. We label just before the plant sale.
To create a label (using Microsoft Word):
1. Open a New Blank Document. Go to the Ribbon at the top of the document.
Click on the Mailings tab.
2. Click on Labels.
3. A box comes up which is labeled Envelopes and Labels.
4. Make sure that the Labels tab is in use.
5. Under Print, make sure that the radio button Full Page of the same label is
chosen.
6. At the bottom of the box, click on Options. Under Printer Information, choose
Page Printer.
7. Under Label Vendors, choose Avery US Letter.
8. Under Product Number, choose 5163 Shipping Labels.
9. Click OK.
10. Click on New Document at the bottom of the Envelopes and Labels box. A
label template should appear.
11. I like to darken all the lines on my template for easier visibility.
a. Click on one of the labels. Click on the Design tab. Table Tools appears
at the very top of the ribbon. Click on Table Tools.
b. At the far right, click on the Border Painter.
c. To the left of the Border Painter Box, click on the 1 ½ pt line weight.
d. Now, take the Border Painter Brush and click on all the lines of your
template, including all the lines in the middle of the template. Now, all
the lines on your template should be darkened.
e. When you are done, click on the File tab. Choose Save.
f. Pick out the spot on the Hard Drive or cloud (or create a new File Folder)
where you want to save the document. I usually name the template
Avery Label Template 10 per sheet 5163. Save the file.
Using the Label Template:
1. Open your template document (Avery Label Template 10 per sheet 5163).
2. Go to the File Tab. Choose Save As and rename your template document. For
example, you could name the new file Tomato Candyland Red Hybrid or
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3.
4.

5.

6.

7.

8.

9.

whatever tomato you are making a label for. Save the file. Congratulations,
you have now preserved your original template document, and are now using
a new label document called Tomato Candyland Red Hybrid.
Now go to the internet and find a fantastic picture of your tomato. Use your
right click menu to choose and copy the picture.
Paste the picture into one of your blank labels on the template. Click on the
picture; the Picture Tools menu should come up. Use the Picture Tools menu
to make color corrections, reduce or increase the Height and Width of your
picture, or Crop as needed.
When clicking on your picture, you will notice a small box at the upper right of
thee picture. Click on this Layout Option menu and choose In Line with text
(the first of 6 choices). This will enable you to drag your picture anywhere
within the label. I usually drag my pictures to the right (sometimes the print
alignment cuts off part of the picture and this prevents losing any of the
written information on your label).
Enter the name of the tomato and other information: “CANDYLAND HYBRID
TOMATO. Indeterminate. 55-65 days. 2016 All America Selections winner.
Currant (pea-sized tomato) on a compact and tidy plant. Trusses of tiny
tomatoes are on the outside of the plant and can be harvested at one time.
Tons of sweet red fruits are great for snacking. High Vitamin A and C. Support
the plant because of heavy fruit load.”
Note that I check at least 5 or 6 vendors, and reviews (if available) before
writing up my description. Sometimes vendors differ in their descriptions. For
example, one vendor listed Candyland Tomato as an Open pollinated (that is,
non-hybrid), but it is indeed a hybrid. I capitalize and bolden the name of the
tomato. The growth pattern, days to maturity, and special features are in
bold. I always try to include a reminder to stake the plant if needed. I try to
leave a line of blank space at both the top and bottom of the description, to
make it easier to peel off the labels.
Once your label is perfect, you reduced the font size, justified the margins,
corrected the grammar and spelling, copy the label to the rest of the nine
labels on the temple. Be sure to save the finished page of 10 labels.
On our printer, we must position the blank label sheets face down to end up
printing on the correct side.
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Sample Printed labels
BIG BEEF HYBRID TOMATO. 73 days. AllAmerica Selections Winner. Large, vigorous,
indeterminate plants produce extra-large,
10-12 oz. ruby red tomatoes are firm, juicy
and highly flavored. Provide good support.
Old time tomato flavor. Early to bear. Yields
heavily in all regions from summer to frost.
Resistant to verticillium wilt (V), fusarium
wilt (F) races 1 and 2, nematodes (N), and
alternaria stem canker (ASC), gray leaf spot
(St), and tobacco mosaic virus (TMV). "Best
tomato yet developed".

BIG BEEF HYBRID TOMATO. 73 days. AllAmerica Selections Winner. Large, vigorous,
indeterminate plants produce extra-large,
10-12 oz. ruby red tomatoes are firm, juicy
and highly flavored. Provide good support.
Old time tomato flavor. Early to bear. Yields
heavily in all regions from summer to frost.
Resistant to verticillium wilt (V), fusarium
wilt (F) races 1 and 2, nematodes (N), and
alternaria stem canker (ASC), gray leaf spot
(St), and tobacco mosaic virus (TMV). "Best
tomato yet developed".

BIG BEEF HYBRID TOMATO. 73 days. AllAmerica Selections Winner. Large, vigorous,
indeterminate plants produce extra-large,
10-12 oz. ruby red tomatoes are firm, juicy
and highly flavored. Provide good support.
Old time tomato flavor. Early to bear. Yields
heavily in all regions from summer to frost.
Resistant to verticillium wilt (V), fusarium
wilt (F) races 1 and 2, nematodes (N), and
alternaria stem canker (ASC), gray leaf spot
(St), and tobacco mosaic virus (TMV). "Best
tomato yet developed".

BIG BEEF HYBRID TOMATO. 73 days. AllAmerica Selections Winner. Large, vigorous,
indeterminate plants produce extra-large,
10-12 oz. ruby red tomatoes are firm, juicy
and highly flavored. Provide good support.
Old time tomato flavor. Early to bear. Yields
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alternaria stem canker (ASC), gray leaf spot
(St), and tobacco mosaic virus (TMV). "Best
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alternaria stem canker (ASC), gray leaf spot
(St), and tobacco mosaic virus (TMV). "Best
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10-12 oz. ruby red tomatoes are firm, juicy
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heavily in all regions from summer to frost.
Resistant to verticillium wilt (V), fusarium
wilt (F) races 1 and 2, nematodes (N), and
alternaria stem canker (ASC), gray leaf spot
(St), and tobacco mosaic virus (TMV). "Best
tomato yet developed".
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Appendix 2: CHEAT SHEET- by Sylvia Peters, Ramsey Co. MG
START DATE: 3rd or 4th week of March
CONTAINERS AND CLEANLINESS: New 4.5” pots orUsed 4.5“ pots soaked in a bleach solutionmix 1 part bleach to 9 parts water
soak and scrub 10-15 minutes, rinse in clear water
SEED STARTING MIX: Schultz Potting Mix or Ferti-Lome have given good results
HOW TO PLANT: 20 seeds per 4.5” pot, sprinkled on top of soil mix
then, lightly cover with soil mix
LABELING 1: Do it immediately! Have labels with varieties listed and ready
BOTTOM HEATING: Use a Seedling Heating Mat under newly potted seeds
WATERING: Bottom water in the tray and loosely cover pots with bubble wrap
FERTILIZING: Use a diluted mix of granulated fertilizer such as Miracle Grow
1 teaspoon per gallon of water—every other watering
NURSERY & LIGHTING: 4’ wide shelving units with 4’ long fluorescent shop lights
suspended on chains to raise and lower lights 1-2” above pots and plants
TRANSPLANTING 1: When 4” tall, transplant largest plants to 2” pots
Fill pots with a small amount of soil, put roots near bottom and fill around stem
LABELING 2: Immediately label each pot with a stick listing the variety
FUNGUS GNATS: Yellow sticky traps at the soil surface as needed
TRANSPLANTING 2: When transplants outgrow 2” pot, transfer to 4.5” pot
Place plant and soil in 4.5” pot and fill with more soil up to lower leaves
LABELING 3: Immediately move label sticks from the 2” pots to the 4.5” pots
SPACE: For each seed that grows, you will need enough space to accommodate it
Transplants will have the same light and water requirements as previously
HARDENING OFF: Place transplants outside after frost starts going out of the ground
Cover transplants with a translucent material
Open north end during the day for a breeze and close at night
Consider building a:
HOOP HOUSE: Read through directions in main body for instructions
LABELING 4: See Appendix 1 for examples of sticky-back labels to attach to pots for sale

